The PCLIMIOS magazine

Volume S4 November, 2014

Netflix On Your
PCLinuxOS System

Quicker Tipper:

Getting Your Netflix Fix
And The Walls
Came Tumbling Down
PCLinuxOS Family Member
Spotlight: JohnW _57

Shellshocked?
Maybe, Maybe Not

Game Zone: Blockstorm

GIMP Tutorial:
"Out-Of-The-Frame" Effect

Inkscape Tutorial: How To
Create Puzzle Pieces

And more inside!




Table Of Contents

: The PCLinuxOS Magazine
Welcome From The Chief Editor 3 _ _
7 Created with Scribus
Netflix On Your PCLinuxOS System 4
Quicker Tipper: Getting Your Netflix Fix 6
Screenshot Showcase 9
And The Walls Came Tumbling Down 10
Screenshot Showcase 11
ms_meme's Nook: Big PCLOS 12
Shellshocked? Maybe, Maybe Not 13
Screenshot Showcase 15
PCLinuxOS Recipe Corner 16 .
Inkscape Tutorial: How To Create Puzzle Pieces 17 ( @ij@
Screenshot Showcase 19 - _

. . . A magazine just isn't a magazine
PCLIﬂUXOS Fam"y Member Spotllght.' jOhn W_57 20 without articles to fill the pages.
Screenshot Showcase 21 If you have article ideas, or if you
Game Zone: Blockstorm 22 would like to contribute articles to the

. PCLinuxOS Magazine,
GIMP Tutorial: An "Out-Of-The-Frame" Effect 24 send an email to:
Screenshot Showcase 26 D g @dna el
PCLinuxOS Puzzled Partitions 27 We are interested in general articles
about Linux, and (of course), articles
More Screenshot Showcase 30 specific to PCLinuxOsS.

PCLINnux<xOS Magazine O Page 2


mailto:pclinuxos.mag@gmail.com
http://www.linuxfoundation.org/
http://www.scribus.net

Welcome From The Chief Editor

Halle-freaking-lujah! Some may be tearful, but not
me. Adobe announced that it was pulling the plug on
support for the Linux version

means of streaming video content. When that day
comes, the death bells will toll for Adobe Flash, and
it will be

of Adobe Reader. Can | have
an AMEN?! | seriously doubt
that Adobe Reader will be
missed on Linux. In fact, |
seriously doubt that Adobe
Reader would be missed on
ANY platform, should it
disappear entirely.

There was a time when
Adobe Reader was the ONLY
way to view PDF files. But
those days are long, long
gone. Today, there are enough programs to fill a
country bushel basket full that can read PDF files.
Granted, this is largely due to Adobe making the
PDF format an open format. But in the end, it has
made Adobe’s own PDF viewer irrelevant.

The other part that made Adobe Reader irrelevant is
Adobe Reader itself. | guess you could make an
argument that Adobe’s decisions regarding Adobe
Reader might also be responsible. Throughout its
history, Adobe Reader has been riddled with as
many security vulnerabilities as Windows has been.
At least under Windows, it went through a very long
period where it was bundled with every piece of
crapware and malware known to mankind, or at
least it seemed. It wasn't a good situation trying to
get rid of the browser hijackers and other *ware that
was being forced down your throat.

The only thing that would make me happier would
be to see the painful and inevitable death of Adobe’s
Flash. Thankfully, it's looking like it may be on its
way out, as well. I'm eagerly awaiting the day when
HTML 5.x supplants Flash as the predominate

relegated to a
sour footnote in
computing
history. That day
cannot come
fast enough.

On a more

positive and
upbeat note
(and it's hard,
from my

viewpoint, to be
any more positive than witnessing the death of an
Adobe product), YouCanToo has come through
again for the PCLinuxOS community. He has started
a live IM service called PCLOS-Talk. You can access
it via Kopete or Pidgin. We’'ll cover it in a LOT more
detail in the December 2014 issue of The
PCLinuxOS Magazine. Meanwhile, you can sign up
for  an account by heading over to
http://pclostalk.pclosusers.com. The list of online
services YouCanToo provides for the PCLinuxOS
community is hard to keep up with. Let's see ...
pclosmail ... myphotos ... LinFX ... the magazine
server ... the master repository for PCLinuxOS ...
the PCLinuxOS Knowledge Base ... and I'm certain
that I'm leaving something out of that laundry list.

| think | can speak for the PCLinuxOS community by
saying thanks, YouCanToo, for all that you do for our
favorite Linux distro. Somehow, just saying thanks
doesn’t seem like near enough.

Until next month, | bid you peace, happiness,
serenity and prosperity.
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Netflix On Your PCLinuxOS System

by YouCanToo

Up until now, watching Netflix on PCLinuxOS meant
you had to jump through hoops. For some users, it
worked, and for others, there was no joy! Now all
PCLinuxOS users can enjoy watching Netflix on
their system.

Let's begin by installing some software.

Using Synaptic, install both of the following files.

1. NSS - This is the Netscape Security Software
libraries that support cross platform development
applications.

2. Google-Chrome-Stable

Now we have everything installed that we need to
enjoy watching Netflix.

To watch Netflix, simply enter the
command in a console window.

following

google-chrome --no-default-browser-check --
user-agent="Mozilla/5.0 (Windows NT 6.3;

Win64; x64) ApplewWebKit/537.36 (KHTML, 1like
Gecko) Chrome/38.0.2114.2 Safari/537.36" --
user-data-dir=/$HOME/.config/netflix --
app=http://netflix.com/

Note: Just recently, Netflix stopped requiring a
specific user agent code to use their service. You
can abbreviate the command to google-chrome --
no-default-browser-check --user-data-
dir=/$HOME/.config/netflix --
app=http://netflix.com/ to view Netflix. Also,
you can place “ &” (without the quotes) at the end of
the command line to free up your console window.
We’'re leaving the original command included, just in
case there are some users who find that they need it
in order for Netflix to work on their system.

Under the General tab, enter Netflix. If you want an
icon, then click on the icon box just to the left of
where you entered Netflix. This will open a dialog
box to let you select an icon or to search your
machine for an icon to use. In my case, | used
Google to search for an icon and saved it to my
system.

If you are like many others and don't like using a
console window, you can make a link to Netflix on
your desktop. This is for KDE, since that is what |
use. Creating a shortcut on other desktops may vary,
but the process will be similar to how it's done on
KDE. So, let's get started. Just right click anywhere
on a blank area of the desktop. In the popup dialog
box, select "Create New," and then select "Link to
Application." A window like the one shown below will
appear:

Properties for Netflix desktop - Plasma Desktop Shell 2 = = *

General Permissions Application Preview

n Netflix

Type: desktop configuration file
#* File Type Options
Location: [ (desktop)
Size: 573 B (573)
Modified: 09/28/14 11:456 AM
Accessed: 09/28/14 11:46 AM

v OK || @ Cancel

General Permissions Application Preview

Metflix

Type: desktop configuration file
/* File Type Options
Location: [ (desktop)
Size: 562 B (562)
Modified: 09/28/14 11:37 AM
Accessed: 09/28/14 11:37 AM

¥ OK || @ Cancel

Now click on the "Application” tab. In the Description
field, 1 entered Netflix, and then in the Command
field, | entered the same command we used above,
in the console:

google-chrome --no-default-browser-check --
user-agent="Mozilla/5.0 (Windows NT 6.3;
Win64; x64) AppleWebKit/537.36 (KHTML, 1like
Gecko) Chrome/38.0.2114.2 Safari/537.36" --
user-data-dir=/$HOME/.config/netflix --
app=http://netflix.com/
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Netflix On Your PCLinuxOS System
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" NETFLIX

Now just sit back, relax, and enjoy Netflix on your
PCLinuxOS Machine!

If you used the newer, shorter version of the
command in your terminal program — and it worked —
then you can substitute the newer, shorter version of
the command here (without the user agent string).

I want to thank fraterlinux and all the other
PCLinuxOS forum members that helped sort out
how to watch Netflix on your PCLinuxOS installation.

- =

Properties for Netflix.desktop - Plasma Desktop Shell 2 = »

General = Permissions =Application | Preview

Description: Netflix

Chat with PCLinuxOS users

| ol \ from all over
| 4 ’ qﬁ% the World.
| | [ ‘ T <@\ 5
| | == - = : | : - iﬂp lgn Hp
_Add... || Remove Advanced Options . E .’ TODAY’

R "0l How ! Met Your-Mother .
e | 51: E1 “Pilot™
PCLOS- lalk

At this point click on the "OK" button at the bottom :
right corner of the window. The box will close and a htl;p.ffpclﬂstalk.pclnsusers.cnm

new desktop icon will be created.

Comment: [
Command: r-data-dir=/$HOME/.config/netflix --app=http://netflix.com/ Browse...
Work path: =

Supported file types:
|  Mimetype ~Description

— A magazine just isn't a magazine
NETFLIX oo e wws o qaisi i+ without articles to fill the pages.

Documentaries | s - TR If you have article ideas, or if you
' would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com

Thuhderbird

Now, just click on your newly created desktop icon to
start your Netflix experience. To view Netflix full
screen, press the F11 key.

We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.

WHE IS
DAYANI CRISTAL?
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Quicker Tipper: Getting Your Netflix Fix

by loudog

I am well aware of the early days when the frustration of trying to get Netflix to
work on PCLinuxOS was not easy. Believe me. Actually, it was a real pain in the
butt, to be honest. | personally just resorted to using my Android device or PS3,
as | could never get it to work quite right on a consistent basis in Linux. It appears
that those days may be over, with many reports of Netflix being used quite
satisfactorily on PCLinuxOS recently in the forum. | will be using an example from
the “Tips & Tricks” section on the forum for this writeup and all credit goes to our
beloved (mostly anyway) forum members.

PCLinuxOS-Forums

f Hello loudog

e 3 Show unread posts since last visit.
{ Show new replies to your posts

y October 17, 2014, 02:37:01 PM

Help Search Profile My Messages Members Logout

PCLinUxOS-Forums » Help » Tips and Tricks » Netflix on Linux today

Pages: [1] 2 Go Down

oQ 93 Netflix on Linux today
« on: September 24, 2014, 11317:19 AM »
Full Member

S I saw this article on PCWorld. I have not tried yet but I will try later: I hope that it work for you.

00 http://www.pcworld.com/article/2687243/netflix-on-linux-how-to-get-it-today-and-why-its-such-a-pain.html

Well I just followed the steps and it works.
« Last Edit: September 24, 2014, 11:34:11 AM by Q »

Q

I have not tried this yet, so all you readers get to witness everything that
transpires basically in real time. Reading through all the reply posts, | see a
particular tip that suggests to make a graphical shortcut on the desktop. Hey, that
is exactly what | would like, a little icon that | just click on and Netflix starts.
Wooohooo! So let's roll up the sleeves and give er’ an ol PCLos try, ay'?
Whaddaya’ say, friends? It appears from reading the post that the first thing we
need to do is install the NSS library from Synaptic. Easy enough, click the
Synaptic icon aannnnd... What the heck??? Arrggg, just my luck, Synaptic won't
open from the launch icon. The update notifier icon doesn’'t seem to be working

either. Pesky updates and new kernels anyway ... delays, delays. Oh well, these
things happen from time to time. | will have to check into the cause later. For now,
I will just launch it from the shell (I hope).

- loofy : bash - Konsole
File Edit View Bookmarks Settings Help

[loofy@localhost ~]% su
Password: I
[root@localhost loofyl# synapticl

Yep, that seems to work every time. | will scroll down to the nss heading, and we
see that it is already installed. Cool beans.

%o
File Edit Package Settings Help
c %5 ¥ é &
Reload Mark AllUpgrades  Apply Properties Search
L s Package Compone
|n5talled L] Inuuvegu-rinrmvdl e ACU_US
B nscd %x86_64
Installed (local or obsolete)
Not installed o s
0 nss-doc %x86_64
0 nss_ldap x86_64
B nss_mdns x86_64
B nss_tcb %x86_64
0 nss_tinycdb x86_64
B nss_wins x86_64

We are now instructed to install the latest Google Chrome browser package. |
have this installed already so no need to go back into Synaptic for me. If you do
not have it installed, do so now. The next step is to create an application launcher
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icon on the desktop. Easy enough (I hope I’'m not going to regret saying that). |
will right click on the desktop and select: Create New > Link to Application.

' Create New

> ES Folder...

J . - Text File...
[ Paste Clipboard Contents Ctrl+V @ HTML File...

i2 lcons * @ Link to Location (URL)...
I Refresh Desktop F5 @ Basic link to file or directory...
& Open with Dolphin o Link to Application... B
& Konsole [ Link to Device

© Run Command...

< Add Widgets... Alt+D, A

< Add Panel >

w Activities... Alt+D, Alt+A

7l Lock Widgets Alt+D, L

[ Lock Screen

(4 Leave...

+* Folder Settings Alt+D, Alt+S

This will bring up the application link configuration window. Select the application
tab. Add the name and a note. The post reply says to type the command “google-
chrome --no-default-browser-check --user-data-dir=/$HOME/.config/netflix --
app=http://netflix.com/” into the “Properties” box, but | do not see a “Properties”
option in the window.

" . Properties for Program.deskto... (2 & =
General | Permissions | Application | Preview

Description: netflix

Quicker Tipper: Getting Your Netflix Fix

I can be kind of lazy sometimes when it comes to typing in commands, and this
happens to be one of those times. | will just copy the command from the forum
post and paste it into the box that says “command” and hope it works. Yep, | fly
by the seat of my pants much of the time. It makes life all that more exciting (all
PCLinuxOS users do to a point). OK, now that we have those items done we will
click on the “OK” button. | now have a rather plain looking icon on the desktop
that says “link to application” and if | hover my cursor over it informs me that this
is “test”.

Link to Application
test

@)
iy
Linis 59

,{jﬂyﬂr:ﬁ'hm

I would personally prefer an icon that denotes TV watching, so | will change this
to something more fitting. To do this, we will need to go to the icon on the desktop
launcher (the question mark icon), right click it and select properties. This will
bring up the application launcher window again. Clicking on the icon in the
window will now bring up the icon selection window. Note: You can change most
all icons on your computer in this manner. | will expand the window to get a fuller
view of all the available icons to choose from and also check the different types

Comment: test - Preahl R
Command: & ~app=http://netflix.com/| | Browse... Xine E '! £~ -.h- E"l"" -
Work path: = -
e = phonon-x... photolay... picmi €  planner plasma  plasmaap...
Supported file types: b —
Mimetype ~ : Description o9 plcm@ _' "
preferenc... preferenc... preferenc... preferenc... preferenc... preferenc...
. =g 299 7N
Add... Remove Advanced Options 4
= =] 4 o
¥ OK_Hu-Cancel preferenc... preferenc... preferenc... preferenc... preferenc... preferenc...
PCLINuLxOS Magazine Page 7



before deciding on one. | personally do not require a Netflix icon. Just a simple
TV will be enough for me to remember what it is. | like this little happy face TV, so
I will click on it. (After all, it does say “Pick me”).

I now have my selected icon on the desktop, and it looks great. Now that we have
all the configurations from the post implemented, it is time to see if our little
project worked and if it does??? | will be watching the last season of Walking
Dead with my wife on the 42" 120hz 1080p display | purchased for my computer
for this very reason. Ready??? Set??? Click!!!

e L

Netflix - Watch TV Shows Online, Watch Movies Online

Sign In

Watch TV shows & movies anytime,
anywhere

Start Your Free Month I i |i
I l

https:/fwww.netflix.com/Login?locale=en-US|

SEXReBEEGLAT

Yesss, my friends, it works. After signing in, we enjoyed the one service that used
to be such a pain to get to work on our beloved distro (or most any other Linux
distro for that matter). Yes, PCLinuxOS continues to shine brightly, and all those
points of light that are our fellow users, supporters, developers, maintainers,
tippers and posters come together as one brilliant beacon in the darkness we
know as proprietary software. I'm Lovin’ Linux.

Quicker Tipper: Getting Your Netflix Fix

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!
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And The Walls Came Tumbling Down

by Paul Arnote (parnote)

If you want to learn how to view Netflix on your own
PCLinuxOS computer, please check out YouCanToo’s and
loudog’s articles, elsewhere in this edition of The
PCLinuxOS Magazine.

Someone pinch me. | must be dreaming. Netflix is
viewable natively in PCLinuxOS? And not just only
PCLinuxOS, but all Linux distros? Like many other

Sure, lots of Linux users would/could run a copy of
Windows in VirtualBox, but | didnt want to go
through all of that hassle. | also didn’t want to put up
with the poor video performance that historically has
plagued VirtualBox clients. Even though today’s
VirtualBox has much improved video performance,
that hasn't always been the case, and | still didn't
want to run Windows just to watch movies. Running
Windows in VirtualBox ran counter to the reasons |
switched to Linux, and it makes me feel “dirty” every
time I launch Windows in VirtualBox.

HTML 5.1 has DRM, inserted at the insistence of
content providers. But the DRM in HTML 5.1 is
platform independent. All that is necessary is to use
a browser that is compliant with the proposed HTML
5.1 standard. So Linux users — and users of other
“less popular” operating systems — are no longer
excluded (or shouldn’'t be excluded) by content
providers use of platform-specific DRM modules.

This next bit may just be my perspective, but | really
don’t think so. As more and more people get tired of

Linux users, | never thought this day
would come. Like many other Linux
users, Netflix's lack of support for Linux
has kept me from being one of their
customers. Now, that whole mindset is
changing. With support for Linux, I'm
now considering becoming one of their
customers.

The lack of Netflix support has often
been cited as a major reason for not
switching to Linux by many potential new
Linux users. In fact, for the longest time,
Linux seemed to be the last bastion of
users to finally receive some “love” from
Netflix. Netflix was available on
Windows, Mac OS X, Android, iOS and
even Blackberry. So, for many users, the
lack of Netflix support for Linux has
hindered wider adoption of Linux. |
wonder what will happen, now that this
barrier has been removed. Every Linux

the bigger and bigger mess that Windows
has become - increasingly so with
virtually every new version — more and
more people seem to be discovering
Linux. The popularity of Linux has
definitely been buoyed by the emergence
of Linux as a powerful gaming platform.
The release of Valve's “official” Steam
client for Linux in September 2013 has
certainly put some steam into the
adoption of Linux (sorry for the pun).
Valve even has a Linux based gaming OS
in the works, called SteamOS, which is
currently in open beta testing.

Bit by bit, the walls and barriers — whether
real or perceived — that prevent users
from adopting Linux are being torn down.
Those of us who have already made the
transition from the commercially available
operating systems to Linux years ago
have become covered in cobwebs waiting

distribution in existence stands to benefit
from an increased number of new users with access
to their beloved Netflix accounts. Users who cited
this as the primary obstacle to their adoption of
Linux as their main operating system can now
proceed with the transition.

So what's responsible for Netflix's change of heart?
Well, it's primarily due to Netflix dropping Microsoft's
Silverlight as its main means for applying DRM —
which excluded Linux users, en toto. Instead, Netflix
is now switching over the the proposed HTML 5.1
standard to stream content. Yes, the proposed

for these events to materialize. But finally,
our long wait is being rewarded.

At long last, the walls came tumbling down.
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ms_meme's Nook: Big PCLOS

| use Big PCLOS Big PCLO Big PCL
| use Big PCLOS Big PCL Oh my yeS

And that spells perfection
| sing it with affection
And I'm here to tell you it's all true

| use Big PCLOS Big PCLO Big PCL
| use Big PCLOS Big PCL Oh my yeS

And that spells perfection
It is my selection
My advice is that you use it too

| use Big PCLOS Big PCLO Big PCL
| use Big PCLOS Big PCL Oh my yeS MP3 oOGG
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Shellshocked? Maybe, Maybe Not

by Paul Arnote (parnote)

On September 24, 2014, a security vulnerability was
discovered in bash, the Bourne Again Shell. Bash,
the default in PCLinuxOS, is the basic, text based
command interpreter that allows a user to interact
with their computer from the command line. It is
commonly referred to as a shell. Bash is the default
shell in many Linux distros, and is the default shell in
Mac OS X.

Well, OK. You might be. Shellshocked, that is. You
are, if you haven’t kept your system up to date. But if
you have maintained your updates regularly (as you
should), your system should be patched and
immune from the most common vulnerability.

Users of Windows, Android and iOS are not typically
affected, at least directly. On the latter two OS'’s,
there is a risk only if the user has installed a version
of bash. For example, there are several versions
available in the Google Play store on my LG2
Android phone. While it isn’t clear by reading the
descriptions if those versions of bash are affected, it
would be a safe bet to assume that they are. The
release dates for most of the versions are from
August, 2014, which was before the discovery of the
Shellshock vulnerability.

Bash came about in 1989, originally written by Brian
Fox for the GNU Project as a free replacement for
the Unix Bourne Shell. It's POSIX compliant, and
also incorporated features from csh, ksh and sh. It is
suspected that the newly discovered vulnerability
has been there since the beginning. Other accounts
place the vulnerability going back to version 1.13.
Nonetheless, bash is now up to version 4.3.2, so the
vulnerability has been around for some time now.

Basically, the vulnerability allows a function to be
exported as an environment variable to another
instance of bash. That function can easily include
malicious code. In fact, by the end of September,
more than 1.5 million exploits of the vulnerability
were being tracked. Those exploits ranged from
DDoS attacks to “command and control deployment”
attacks.

It's not difficult to find a very wide assortment of
topics discussing the Shellshock vulnerability, more
formally known as CVE-2014-6271. The best — and
most understandable — discussion of Shellshock |
found was at Wikipedia. Another excellent
discussion was found at troyhunt.com. ZDNet has

also published an excellent FAQ about Shellshock.
So, I'm not going to go into an in-depth discussion
about how it works. | cannot even come close to
doing justice to the topic that the excellent resources
I've mentioned here have done, as well as all of the
other thousands of similar sites doing the same
thing.

How Serious Is Shellshock?

If you were to rate vulnerabilities on a scale from
one to ten, with one being the lowest level of
vulnerability and ten being the highest, most severe
vulnerability, Shellshock rates a 10. In fact, the

PCLINuLxOS Magazine

QO

Page 13


http://en.wikipedia.org/wiki/Shellshock_%28software_bug%29
http://www.troyhunt.com/2014/09/everything-you-need-to-know-about.html
http://www.zdnet.com/the-shellshock-faq-heres-what-you-need-to-know-7000034219/

National Vulnerability Database, sponsored by the
DHS (Dept. of Homeland Security) National Cyber
Security Division and National Institute of Standards
and Technology, rates the Shellshock vulnerability a
10.

Shellshock Timeline

The timeline is interesting because it shows how
quickly the open source community rallied to fix the
Shellshock vulnerabilities. Below is a condensed
timeline that hits the highlights. You can read the
entire timeline here.

September 12, 2014: First report of discovery of the
initial vulnerability.

September 24, 2014: News of the bash vulnerability
released to the public.

September 24, 2014: First patch of bash is deemed
incomplete.

September 26, 2014: Second patch of bash is also
deemed incomplete.

September 27, 2014: Official patch (4.3-027) is
released that eliminates Shellshock vulnerability.

Three additional patches were released between
September 27, 2014 and October 5, 2014. For most
users, the 4.3-027 patch fixed the issue. The
additional patches fix additional possible vectors for
exploitation. These vectors typically represent
special cases that are not common to the average
user, and that are effectively eliminated with the 027
patch.

Who Is At Risk?

Well, just about anyone who's still running a
vulnerable (unpatched) version of bash carries a
certain level of risk. As a “regular” user, your risk is

minimal. But why chance it, especially when the “fix”
is easily obtainable and available? As an individual,
your risk is heightened by the use of untrusted
networks, e.g. public wifi hotspots.

Those most at risk are those running servers. The
bash vulnerability is most easily exploited from those
using CGI scripts to launch another instance of
bash, complete with malicious functions exported to
the environment variables stack.

If you use ssh, you are also at risk. All it takes is
some hacker looking for an open ssh port, and when
it finds one on your system, it's pretty easy for the
hacker to execute malicious commands that will
wreck havoc on your system after executing an
elevation of privileges.

Besides elevating privileges on the affected
systems, Shellshock can and has been used in
DDoS attacks. There are other potential threat
vectors associated with Shellshock, and reading the
aforementioned resources will fill you in on those.

How To Tell If You’re Vulnerable

Thankfully, the test to see if your version of bash is
vulnerable to the two most common exploits is pretty
simple.

First, open a terminal session. At the command line,
type the following:

Shellshocked? Maybe, Maybe Not

env x="() { :;}, echo vulnerable' bash -c

"echo this is a test"

If your system is vulnerable, you will see the
following output:

vulnerable
this is a test

If you system has been patched (e.g., you've kept
your system updated), you will see the following
output:

this is a test

Summary

It's amazing that this vulnerability has been around
in bash for over 20 years, and security experts have
never noticed or realized the problem. It's not
entirely clear how long hackers have been exploiting
it, either. All that computer security folks can do at
this point is speculate and wonder.

One thing is for certain: once word about the
vulnerability came out, the hackers were quick to
exploit it. Fortunately, the two most prevalent
vulnerabilities were fixed in a very short time.
However, systems remain(ed) vulnerable until the
updated/patched version of bash was installed. The
fix (an updated bash) was posted to the PCLinuxOS
repository within a few days. This illustrates why it's
so important to regularly apply updates on your
system.

Although Windows users weren’t directly affected
(bash does not run natively on Windows), any user
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who connects to the internet is/was at risk. Seeing
how the vast majority of network servers run Linux,
all of their private information was just as at risk as a
user who uses one of the OS’s where bash runs
natively. And these days, it's rare to find a computer
that isn’t attached to the internet.
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Can't find what you want? Try the
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PCLinuxOS Recipe Corner

Ingredients

1 pound lean ground beef

1/4 - 1/2 cup brown sugar

1/4 cup soy sauce

1 Tablespoon sesame oil

3 cloves garlic, minced

1/2 teaspoon fresh ginger, minced

1/2 - 1 teaspoon crushed red peppers
salt and pepper

1 bunch green onions, diced

Options: Replace ground beef with
either thinly sliced chicken or beef.

Directions:
Heat a large skillet over medium heat
and brown hamburger with garlic in the

sesame oil.

Drain most of the fat and add brown sugar, soy
sauce, ginger, salt and pepper and red peppers.

Simmer for a few minutes to blend the flavors.

Serve over steamed rice and top with green onions.
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Inkscape Tutorial: How To Create Puzzle Pieces

by Khadis

Do you like playing with puzzles? | do. What about
making a puzzle and then challenging your friends to
solve it? It might be fun and entertaining. So, in this
tutorial, | would like to show you how to make simple
puzzle pieces.

1. Open up your Inkscape and create a rectangle of
any size and any color. Convert it into a path from
Path > Object to path (Shift + Ctrl + C).

2. Create a circle (or an ellipse). You can make it
any size and any color, but | recommend you to
create a circle that is smaller than your rectangle.
Duplicate the circle three times using Ctrl + D until
you finally get four circles. In the illustration, | have a
green rectangle and yellow circles without stroke.

3. Put one circle on the left part of the rectangle. You
may place it randomly. This means you do not need
to put the circle perfectly vertically “justified” to the
rectangle. But please note, that if you want to make
this puzzle playable, you may want to consider to
“justify” the circle into “center on vertical axis”. The
same height of rectangle with the same puzzle's
“hole” position will fit each other.

4. Do a “union” operation by selecting the circle, hold
down your Shift button, then click on the rectangle.
Press Ctrl + + or access the union function from the
Path > Union menu.

5. Now, put the second circle on the right part of the
rectangle. Place the circle so that its bigger part is
inside of the rectangle.

6. Do a “difference” operation by selecting the circle
hold down your Shift button, then click on the
rectangle. Press Ctrl + - or access this function from
the Path > Difference menu. Now, your rectangle
should look like this (right, top):

7. Repeat steps four through six, by putting the third
and fourth circles on the top and bottom part of the
rectangle. The final result may look like either of
these (center and bottom right):
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Inkscape Tutorial: How To Create Puzzle Pieces

8. Of course, you can explore the way you place the 12. Or you can do this simple trick: select the first
circles to produce cooler pieces of puzzle. puzzle, and then remove the right hole's nodes and
return the curved side into a flat side.
9. To give a “final touch”, you can convert the puzzle
into curve and modify it into smoother shape. You
can use Edit path by nodes tool (F2) and use the
available modifying tools or modify your nodes
manually.

14. Now, it's your turn, to create your own your very
own puzzle creation.

10. As | mentioned in step three, to make these
pieces of puzzle playable, you should create the
same “distance” of circles placement and flat
rectangle. But, if your imagination flies further and
you want to create a curved puzzle, as in the step
nine above, then you should totally modify the other
pieces of your puzzle.

11. Duplicate your curved puzzle piece, then place =] E tg) E1 B‘ R AREE D (

the new piece close to the first one. Hold the Ctrl

button while moving your object so that it can move -0 [l ol [ o D VAL S S RS l{'

straight. By using Edit path by nodes tool (F2),

adjust the size or even the position of your first

puzzle's hole and puffed part. 13. Put them “stuck to” each other, then do the
“difference” operation. Your second puzzle will be

removed. Duplicate (Ctrl + D) the first puzzle again,

and stick the second one to it. Give them different
colors (top, right). DOWNLOAD
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Posted by Dalapane, on 10/3/14, running KDE.
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PCLinuxOS Family Member Spotlight: JohnW 57

as told to Smileeb

This month, we get to
learn more about
JohnW_57.

How old are you?
56.

Married,
what?
Single.

single or

Children, grandchildren?
No.

Retired or working and for how long and at
what?
Still working since 1977.

Are you handy with your hands and have any
hobbies?
A bit, home-built computers.

What is your education level?
Moderate.

Do you like to travel, go camping?
Not really.

What caused you to try Linux and join this
forum?

(See at:
http://www.pclinuxos.com/forum/index.php/topic,121
862.0.html)

| started using computers in 1982 with the
Commodore VIC 20 and C64, and later with a C128
with a bit using the CPM OS on that machine. | also

had a MSX computer (the 1st MS OS), and a little bit
later my 1st x8(8)6 computer with MS-DOS 2.11 with
the Word/Calcstar and DBase on a green/black
monitor (with the Hercules video card).

After using MS Windows 3.11 and 95/98(SE), | did
my first try with Linux with Red Hat 6.4 with a simple
WM as the desktop (I had to start it with the startx
command), and using devices with mount and
umount commands. | also tried a few Suse installs
(now OpenSuse).

A bit later, | installed Mandrake 7 from a linux
computer magazine, and updated to the paid
versions later (the Internet was slow then, with
28K/sec).

| broke with Linux for a few years for Windows 2000
and XP until October 2004, when | saw a
PCLinuxOS preview 0.7 on a torrent site with the
nvidia driver 1SO. | burned it onto a cd and tested
the LiveCD, and a bit later on the hdd. The first
install was without problems, but met a few issues
which were solved with preview 0.8 (one issue was
playing mp3 files correctly).

With preview 0.93, | did the first install with MiniMe
(Junior and Big Daddy were released a bit later).
The reason why | used Minime was to localize
PCLinuxOS in the Dutch language. It was less work
than with Junior and Big Daddy. | then wrote a how-
to on the PCLinuxonline forum. | had to modify the
rpm macro file and reinstall a lot of packages while
searching with Kpackage to discover which rpm
packages have no files for translation.

PCLinuxOS 2007 was and is still a big highlight for
PCLinuxOS. | installed all testing installs. | think
2007 is still the biggest success in PCLinuxOS
history!

The year 2009 was a bit difficult (some users and
devs know why), but a positive point was addlocale
(an easy localization feature). However, I'm still
using PCLinuxOS in 2014 as a user and tester. |
built a new rig with the latest Intel hardware
(Haswell), and PCLinuxOS 2014 does fine on it.

Thanks go to all the devs, packagers, testers,
moderators, PCLinuxOS Magazine Crew....

Also for me:

Bill Reynolds, aka Texstar

Jim Jensen, aka Exterm (IRC)

TheDarb (IRC)

Pinoc (Localization, KDE4 and LO manager)

N1PTT (IRC and testing) posthumously.
Joble (Packager and Moderator) posthumously.

Wow... 11 years goes fast!

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

If you would like to be featured in PCLinuxOS Family

Member Spotlight, please send a private message to
smileeb in the PCLinuxOS forum expressing your interest.

Linux Docs

diénet Linux Man Pages
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PCLINuLxOS Magazine ®) Page 21


http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
http://www.fsf.org
http://www.dosgamesarchive.com/
http://www.linfx.com

Game Zone: Blockstorm

by daiashi

About The Game

Blockstorm is a FPS game set in a world
made of destructible blocks. The voxel
nature of characters and maps and the in-
game editor allows you to fully customize
your game and quickly share your
experience with other players. You are free
to create your own maps and characters
from scratch, or to customize existing ones.
All maps and characters included in the
game are made with the same tools that are
available to the public. Weapons range from
precise rifles to heavy machine guns, or even
explosives capable of destroying hiding places and
creating tactical advantages. You can pick out your
own load out, choosing between a set of weapons
configured by the creator of the map. You can build
everything in Blockstorm, and you can destroy it.

Blockstorm is available on Steam Early Access.
Features Include

» Destructible environment

* Game modes: Deathmatch. Team Deathmatch,
Assault.

* Map Editor

* Characters Editor

» User created content can be shared with other
players.

System requirements:

Fully updated PCLinuxOS and Steam

Hardware:

Minimum:
OS: PCLinuxOS

Processor: Intel Core 2 Duo

Memory: 2 GB RAM

Graphics: Nvidia Geforce 8600M GT

Network: Broadband Internet connection

Hard Drive: 200 MB available space

Additional Notes: With the minimum
configuration, disable dynamic shadows
and effects

Recommended:

OS: PCLinuxOS

Processor: Intel Core i3
Memory: 4 GB RAM
Graphics: Nvidia Geforce GTX 550 ti

Network: Broadband Internet
connection

Hard Drive: 512 MB available space

About The Company

GhostShark Games is a development
studio founded in Rome by talented and
experienced developers sharing their
passion for games. They gained a strong experience
in game development, especially with Unity3D, both
on desktop and on mobile platforms. We are
currently developing our own IPs, but we also can
provide game development services for hire.

Some Gameplay Screenshots

B8-/38a
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Game Zone: Blockstorm

STORE LIBRARY COMMUNITY HYPNOTIC SNAKE

Blockstorm Demo
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It's easier than Ezmc2 ,
It's elemental 7
It's light years ahead !
It's a wise choice \{
It's Radically Simple
It's ...

R

Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account, if
you do not already have one. Once you have Steam
up and running, go to the store tab. Click on the
Linux tab if you wish and search for the game. Click
on and download the demo. If you have updated
your system, including graphics drivers, you should
be good to go.

http://store.steampowered.com/app/322010

4, MultiHadla

nf‘Lﬂr— TXCS Full Mon ty - Everything you m.ight warolt or need —

plus the kitchen sink!
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GIMP Tutorial:

An "Out-Of-The-Frame" Effect

by Meemaw

| saw this tutorial a while ago and thought it was
interesting. Your finished product gives the effect of
your subject emerging from a photo.

You want to start with a photo of something that is
moving toward you. Since | went to a parade
recently, | have several photos of trucks and cars
taken from the front. For this you will also need an

T L

image of a picture frame. | downloaded a framed
painting image from Wikimedia Commons and cut
the photo out, leaving the frame. You can also make
a picture frame using the method from my earlier
tutorial in Inkscape. Now you are ready.

Open your photo in GIMP. You can resize it to
approximately the size you want your finished image
to be. Using the lasso tool, outline the object you
want to bring out of your photo. In mine, it is the red
truck in the foreground.
shadow, too.

| grabbed part of the

L 3

While that is selected, click <CTRL> + C (Copy), but
before you paste it, create a new, transparent layer
and paste it there (<CTRL> +

V). Also, create a new layer - &&
filled with a light grey (or =s|*iem 5.

whatever background color you
think might look good) and send
that layer to the bottom.

|Lock: 4

Select your layer which
contains the original photo, and
open the photo frame graphic. .
Copy and paste the photo TeEsvme 0
frame onto your original photo, ‘

resizing if necessary. This might be a good time to
save your project.

Still on that layer, click on the Perspective tool, then
click on your picture.
The perspective tool
will cover it with
gridlines.

...... =z

) 1
Perspective Tool: Change perspective of
the layer, selection or path Shift+P

| am going to grab the left side of my photo and
move it in, making that side of the photo look like it is
farther away. You might have to move it around a bit
to make it look like you want it, but until you click
Transform in the window that pops up, you will be
able to manipulate it. If you click Transform, and
discover you don't like it, you can always undo it
(CTRL> + Z). Don't let it fool you either. As you
move your photo, you will see the image in its
original position behind the one you are moving.
When you click Transform, it will disappear (hext
page, top left).

Check your project carefully as you may have to
move your out of bounds layer a bit to cover the
original photo of the same thing. | had to move the
truck a bit to cover the other image in the original. It
might even be necessary to clone background colors
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over something that you can’t cover. If your lasso
tool was off at all, you might just use the eraser tool
(in one spot in mine, | erased a bit of background |
had selected by mistake to make the front end of the
truck look smoother).

You might need to crop your photo if you moved the
one level around very much. Save your work, merge
your levels down and export your project to your
preferred graphics format (center, top).

This one (center) was fun, too, but gives a little
different effect. | went to Monument Valley in 2012
and took the original photo. | just moved the rocks
and the ground outside the frame.

GIMP Tutorial: An "Out-Of-The-Frame" Effect

| have also seen this wallpaper (right), which is also
very interesting. | downloaded it from
deviantart.com. I'm sure it was made in much the
same manner. Deviantart has several similar
designs.

Let your imagination go, and I'm sure you can make
something wonderful!

The
PCLinuxOS
Magazine

Created with
Scribus
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS I1S" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users

A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement

These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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Posted by welrdwolf on 10/18/14, running LXDE.
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PCLinuxOS Puzzled Partitions

6
9 3

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the humbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same.

LiruX:
SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles

1point: E,A ILO,N,R, T, L,S, U

2 points: D, G

3 points: B, C, M, P

4 points: F, H, V, W, Y

5 points: K

8 points: J, X

10 points: Q, Z
6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

Download Puzzle Solutions Here
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Triple Word
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Double Word
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Possible score 234, average score 164.
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PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzile: November 2014
Autumn

1. Nuts
2. Fall colors
= 3. Eclipse makes it look red
4. Helps keep you warm outside
5. Nice, meaty stew-like meal
17 ‘ ‘ | | ‘ ‘ | | ‘ | 6. Hand warmers
s ; 7. Atasty toast-topper
g| ‘ | | ‘ ‘ | 8. Remains of the corn _harvest
9. Warm, chocolatey drink
z 10. Ice crystals on everything
11. Halloween costume
1 \ | | \ \ | | \ \ \ 12. Picking all the crops

13. Maple trees product

14. Take one to a football game to stay warm
. . ‘ ‘ | 15. Dessert _

16. Scary holiday

‘ ‘ | ‘ | ‘ ‘ i2 17. Holiday to appreciate what you have

13

Download Puzzle Solutions Here
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Autumn Word Find

VOISZAMAXMEHFURBJIJLKGEIPNTIKPMUP

KKQQFMXVPPSMEFLAVANYNEZLTITIDLVLSEB

Apple Butter

XSQDOGOKIPQRRTOECOOCSEEKNTBYGLC

YCYVQZCKSDSLEATHANKSGIVINGPAEL

Autumn Leaves
Blankets
Chili

EFFKFKEMKXOPZDLVOIWISSOYEPNTIWU
HVEGVDMICNVKCPIQCWNUCEBWAIKMZU
YSKLATSNROCNMEPCCBSATIAIUSMYTETFZC

Corn Stalks

VYTO0CGICCCIQSFIODPRQUUAKZTUTCTEFK

PVRVBZIGTIWLMIKAAEKKXDBVHL
XVXEURDWBAONMGLICGCGJIOLEWU

Football Games

Frost

KPESYAMPSFOPIODRSTAIUYLTRVZUMY
VUSCESBBIJDWCTAOHWFFPPXOQTEVGTFX

Gloves

Halloween
Harvest

TCESTKTSORFLOWFGMJIJRCPSLMTYHEFBE

XDMFRRNAGHPMACWUEVIJIASLTAGVCLPL

Hot Cocoa

YQAGFJIUWSUFYUTNQGXJUQEWAMXUSTI
NGGMOAVHDXTGFCTOOJAVEKJIBQORDWDO

Maple Syrup

Moon

QI I LISFCUJIJBNUHVIBOBHFUYDZTWU
HEYHLHTPZNCNOQQMGOTPHAASTXRZCS

I QL
ZLL

Pumpkin Pie

FIAFVOAZNDAAYTMWONINZRLELCTYOX

Roasted Chestnuts

Scarecrow

RABZXWIPBCOETESRWSLBBZLHGPCEUTC

ZDTHBLUZQYIRWNAEYCCELPOCGWVUR/Z

Spiced Cider
Squash

VIOVABEVVHFRQSZOHENCAXWWDOGRET

XMOONHCTIXXQBEOZBCCMNVETIPIZUSTI

WTFEWWFMWIJIZHAWMQLXDFKTIECGXRERD

Sweatshirt

JGYJCLFPBJEGFHKDHYPEEANSUXVITH
BOAKUQUWOPEFGDZFEHWTTPFGWRTTCOL

Thanksgiving

RHUAOEOWBSOUWCWMWQZISSWAAXLSVGE
UCWVDSFHFJIJBTSVTRAQQAVBAHCHTILTIZJ
DSYNCXKWRFIRKZHIGYNMCHDOBUPLHTIN

SQUASHUEDZBGQGDHGGHJABBVRUCOXH
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More Screenshot Showcase

Posted by Taco.22, on 10/24/14, running Openbox.
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Posted by OrionH, on 10/21/14, running Xfce.
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Posted by Yankee, on 10/17/14, running LXDE.
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